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How to Combine PDF Files
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To merge PDFs, follow the four simple steps below.


	Download and install PDFChef by Movavi. Open the program and choose Merge from the tools menu.
	In the window that opens, click Select Files and choose the files you want to combine.
	To combine PDF documents, click Merge.
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By clicking the download button, you're downloading a trial version of the program.*
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There are many situations when the ability to merge PDF files can be helpful – you may need to merge scanned documents, combine images into a single PDF, or just copy an individual page from one PDF file into another. To accomplish these tasks, you’ll need a PDF compiler. Luckily, there are plenty of tools for merging PDFs, both online and offline. For example, you probably know about Adobe® Acrobat®, which is one of the best-known programs for working with PDF files. But, of course, you can merge PDFs without the Acrobat® software and use one of many alternatives.
In this article, we’ll describe how to use three desktop apps for Windows and Mac, a built-in tool on Mac computers, and an online PDF editor. We hope this review will help you choose the option that best suits your needs.




How to combine PDF files on Mac or Windows 10 with PDFChef by Movavi


The first tool we'll review is PDFChef. It’s an advanced desktop application for both Windows and Mac that makes working with PDF files a fast and easy process. With Movavi’s PDF merger, it takes just a few clicks to merge two PDF files into one.
The app has a simple and intuitive interface, so you won’t need to spend much time learning the program. In addition to combining PDF files, PDFChef offers a range of editing features you may need when working with PDFs. It enables you to split PDFs files, delete unneeded pages, edit text, rotate and rearrange pages. Another important feature is the addition of a signature, which is both easy and secure – with PDFChef, you can be sure that your documents are protected. And, of course, the program enables you to convert text and image files between popular formats. To check out this app, you can use the trial version that’s available for free for 7 days.
PDFChef offers three different ways to merge PDF files and images. Below, you’ll find step-by-step instructions for each of the approaches. Take a look at these guides and decide which option is the most convenient for you.



[image: ]




How to merge PDF files using the PDF merge tool



Step 1. Install PDFChef by Movavi


Download the PDF joiner, launch the installation file, and follow the instructions on the screen.
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Step 2. Add the PDFs you want to join together


Run the program and click Merge in the tools list. In the window that opens, click Select Files and choose the files you want to merge. You can also drag the files into the app’s working area.
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Step 3. Combine the files into a PDF


You can rearrange the files you’ve added by dragging them into the desired order. To create a single PDF from these multiple documents, click Merge. The new document will open in another tab, so you can do more editing if you wish.
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Step 4. Make edits and submit them


In the preview tab, you will see the merged file with all the pages from the files you added. The pages will appear in the order in which the documents were placed earlier. Any of these pages can be moved, copied, rotated, or deleted. If you need to add some extra blank space between your pages, use the Blank Page button in the right-hand panel. To save the new file, click File in the menu bar and choose Save As.








How to merge PDF files with images using manage pages mode


Sometimes it's useful to add a batch of images to your PDFs to make the document more understandable and easy-to-read. The software will automatically convert PNG and JPG images to PDF.







Step 1. Get the application


Download, install, and run PDFChef on your computer.
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Step 2. Open a PDF


Open a PDF file in the program and click the Manage Pages button in the top panel. You will see the layout of your document.







Step 3. Import images into your PDF document


To add images as separate pages, click Append Files in the right-hand menu and choose the images you want to add. The additional image(s) can be moved within the document by dragging and dropping them to the desired location(s). You can also import and place an image directly on a PDF page using the Image option from the Edit drop-down menu.
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Step 4. Create a new file


To save the contents to a new file, choose the Save As command from the File menu, enter a name for the file, and hit Save.








How to combine PDF pages from different documents


If you want to select pages from different PDF documents and merge them into a single PDF, we recommend you use tabbed editing.







Step 1. Download the software


First, download and install the software on your PC or Mac.
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Step 2. Prepare the files


Open each source document in a separate tab using the Open File button. Make sure you have selected page management mode in each tab.







Step 3. Combine pages from different PDF files


Then, holding down the Ctrl key, select one or more pages in one document, copy them with Ctrl+C, open the tab containing the target document, and paste the pages with Ctrl+V (or choose Paste in the right-hand menu). You can then manually rearrange the order of the pages in the final document.
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Step 4. Save your changes


To save changes to the current file, use the Save command on the menu bar. To save a copy of a PDF, use the Save As command.







PDFChef

Everything you need from PDF software!
Download for FreeAbout the Windows version
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* The trial version of PDFChef by Movavi has the following restrictions: 7-day trial period, watermark on the output PDF. 


[image: ]



How to merge PDF files online


There are plenty of online tools for merging PDF files, and these tools have their advantages. You don’t have to spend time installing software on your computer, and you don’t risk downloading potential malware. Plus, there won’t be any compatibility issues – no matter what your operating system is, you just need a browser and an Internet connection. Another bonus is that a lot of online PDF editors are free.
So, for those who want to merge multiple PDF files right in their browser, we suggest the PDFChef online service. The online tool is absolutely secure, and you can be sure that no third parties can access your data. This online editor also supports rearranging pages in documents.







Step 1. Visit the website


If you need to combine PDFs into one document online, go to the service website by following the link below.
Online PDF Combiner







Step 2. Upload files


Upload your PDF files using the Choose Files button or by dragging and dropping them into the upload area.
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Step 3. Merge the files and save them


Wait a few seconds for PDFChef to load all your PDF documents and show them in the preview pane. Then just click Save and download – the tool automatically saves the uploaded PDF files to the target folder as one merged file.
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How to combine PDF files on a Mac


To merge PDFs on your Mac, you can use a compatible app like PDFChef by Movavi. It’s a simple and efficient tool for working with PDF files. For detailed information about the program, follow the link below.
Learn more about PDFChef by Movavi for Mac
However, installing a third-party app is not your only option. Mac users are lucky to have a PDF-editing app built into their system – Preview. Although the name suggests that the app is designed for viewing documents, in fact, Preview has a wide range of editing features to offer. The program enables you to fill out and sign forms, annotate and highlight text, crop and rotate pages, and more. Combining PDFs is also possible with Preview. Here’s a simple guide to how to do it.







Step 1. Open your files


Open the PDF files you want to combine in Preview.
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Step 2. Select the pages


For each PDF, choose View and select Thumbnails to show the page thumbnails in the sidebar.
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Press and hold the Command key, select the thumbnails of the pages you want to add to the other document, then release Command.
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Step 3. Merge and save the PDFs


Drag the pages into the sidebar of the other PDF file, and drop them where you want them to appear. To save the result, click File and choose Export as PDF.
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How to combine PDF files on Windows 10


Windows 10 doesn't have a built-in PDF editor, but it does offer tools that can view or create PDF files. For example, the Microsoft Edge browser lets you view PDF files. It also includes some basic editing functions like rotating, highlighting, and drawing. But the browser doesn’t offer the PDF merging feature.
You might make use of Microsoft Word if you want to merge several Word files into a PDF. Simply make a single Word document from the files you want to join and then save them as a PDF. This option will work with images as well – create a Word document, insert pictures, and arrange them as you wish. Then save the file as a PDF.
To combine several PDFs into one, you’ll need special PDF-editing software. One PDF combiner you can use on Windows 10 is Foxit PhantomPDF. As well as the merging feature, the app includes a wide range of editing functions. The program enables you to crop and rotate PDF pages, edit text, convert files, and more. The trial version is available for 14 days. So, if you want to check out the PDF joining feature in this app, launch Foxit PhantomPDF on your computer and follow the steps below.







Step 1. Add files to the program


In the Tool Wizard, find the Merge PDF tool and click Use Now. Alternatively, open the Convert tab at the top of the program window and click Combine Files.
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In the new window, hit Add files. From the drop-down menu, choose the most appropriate option depending on the location and type of files. You can add an entire folder with your files, a web page, scanned documents, or files from the clipboard. To choose files from any location on your computer, just click Add Files. Select the PDFs you want to combine and hit Open. You can also upload images or Word files, and the program will automatically convert them to PDF while merging.
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Step 2. Arrange and combine the files


Arrange the uploaded files and hit Combine. When the merging is done, the preview window will open.
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Step 3. Edit your PDF


Now you can make edits before saving the file. If you want to edit the text, open the Edit tab on the upper panel and click Edit Text. On the Fill & Sign tab, you can add new text or a signature. To delete pages or add new ones, open the Organize tab. Here you can also rotate, crop, and move pages. Use the Watermark button to add a watermark to your pages.
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Step 4. Save your PDF


Finally, you need to save the result. Go to File and click Save. Choose the destination location, rename the file if needed, and hit Save.








How to merge PDF files with Adobe® Acrobat® Pro DC


Adobe® is famous for its software designed to work with PDF files. With Adobe® Reader®, you can view, sign, and annotate PDF files for free. To join PDFs, you can use Adobe® Acrobat® Pro DC. It’s a full-featured PDF editor that enables you to create, edit, and convert PDF files. To explore all the features, you can use the free trial version for 7 days with no function limitations.
If you want to know how to combine PDF files with this software, read the guide below.







Step 1. Add your PDFs to the program


Launch the program and open the Tools tab. Find the Combine Files icon and click Open under it.
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In the new window, hit Add Files and select the PDFs for merging.
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Step 2. Merge the files


Click Combine in the top right-hand corner of the program window. When the merge is complete, you’ll be able to preview the resulting file.
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Step 3. Edit the file


If you need to rearrange the pages, click Organize Pages in the side menu. Change the order of the pages by simply dragging a page and dropping it where you need it. To delete a selected page, click the Trash bin icon. You can also add new pages – click Insert, pick the appropriate option from the list, and select the file. You can choose to insert the new pages at the beginning or at the end of your document.
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Step 4. Save your PDF file


When you’ve made all the necessary changes, save the PDF file. Click the Floppy disc icon at the top-left corner of the app. You can save the file in any folder on your computer – select the output folder, enter the name of your file, and click Save. Alternatively, you can save the file in Adobe® Document Cloud®.



[image: ]




Frequently asked questions
How do I combine PDF files for free?

How to combine PDFs for free:
1. Go to the online PDF combiner website.
Free PDF Combiner
2. Add PDF files by clicking the Choose Files button.
3. Wait for the files to upload and click Save and download to merge PDFs – the tool automatically saves the uploaded PDF files as one merged file.

Is merging PDFs secure?

Yes, merging PDFs using Movavi software is secure because your documents are not sent to any third-party services. When you use the online PDFChef tool, all the editing happens in your browser. Movavi does not save or store your files, so merging using either desktop or online app is completely secure.

How do I combine PDF files without Acrobat®?

If you’re looking for an alternative to Adobe® Acrobat®, try PDFChef by Movavi. Download and install the Movavi software and follow these simple steps.
	Select Merge from the list of tools. Then click Select Files in the new window and upload the files for merging.
	Rearrange the documents if needed and hit Merge.
	Go to the File menu and pick Save. Then select the export folder and hit Save.

Adobe® Acrobat® Alternatives       

How do I combine multiple pictures into one PDF?

To merge images into one PDF file, try PDFChef by Movavi. The program supports JPG, PNG, and BMP image formats.
Simply launch the app and click Merge in the welcome window. Then upload your images and hit Merge. In the preview window, you can change the order of the pictures, rotate them, or delete any unwanted ones. When everything is ready, click the Floppy disc icon to save the result.

How can I split my PDF file?

Here’s how to split a PDF file with PDFChef by Movavi.
	Launch the program and import your PDF file.
	Click Manage Pages and select the pages that you want to save a separate PDF. Then hit Extract on the side panel.
	Type the name of your file, select the export folder, and click Save.
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* The trial version of PDFChef by Movavi has the following restrictions: 7-day trial period, watermark on the output PDF. 
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Have questions?
If you can’t find the answer to your question, please feel free to contact our Support Team.
Visit Our Support Center
Visit Our Support Center

Watch Our Video Guides
Watch Our Video Guides





Similar guides
How to insert pages into a PDF       
How to edit a PDF       
How to sign PDF files       
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